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Introduction to Tiki3D Master Software 
1.1 Overview 

Tiki3D is a fully automated 3D reality modeling software that integrates technologies such as digital 
photogrammetry, computer vision, and computer graphics. It is designed for rapid, fully automated 
3D reality modeling using oblique photogrammetry. The software generates 3D reality models from 
various digital images and scanned point clouds. The modeling results can be widely applied in 
fields such as basic surveying and mapping, urban planning, land resources, military surveying, 
highways, railways, water conservancy, electric power, energy, environmental protection, 
agriculture, forestry, and more. The software plays a significant role in improving the efficiency of 
urban 3D model production, reducing production costs, and promoting the development of 3D reality 
modeling globally. 

 

Software Advantages: 

1.​ Efficient Aerotriangulation Algorithm:  
The unique distributed aerotriangulation algorithm ensures more accurate and robust measurement 
results, enabling parallel processing of large-scale oblique 3D reality data. 
 
2.​ Cluster and Multi-OS Support:  
Supports cluster computing and multiple operating systems (including Linux), as well as 
single-machine multi-instance operation to fully utilize computer resources, achieving higher 
processing efficiency and saving significant modeling time. 
 

3.​ High Model Fidelity and Precision:  
Achieves millimeter-level model accuracy. 

 

4.​ Advanced Node Management and Monitoring:  
Ensures efficient task management and real-time monitoring. 

 

5.​ Multi-Source Data Output:  
Produces mesh models, DEM, DOM, and high precision aerotriangulation results. 
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Tiki3D Reality 3D Modeling Software Modules: 

1.​ Tiki3D Master:  
The main module of Tiki3D reality modeling software, responsible for: 

a.​ Importing datasets, 
b.​ Defining processing settings, 
c.​ Submitting job tasks, 
d.​ Monitoring job progress, 
e.​ Browsing processing results, and more. 

 

 
2.​ Tiki3D Engine:  
Handles the core computational tasks for 3D modeling. 
 
3.​ Tiki3D Viewer:  
Allows visualization and inspection of the generated 3D models. 

 

 

This comprehensive software suite ensures efficient, high-quality 3D reality modeling for a wide 
range of applications. 
 

 

1.2 System Requirements  

Tiki3D software supports running on Microsoft Windows XP/Vista/7/8/10 64-bit operating systems, 
as well as Linux systems such as CentOS, Ubuntu, and NeoKylin. 

 

It requires at least 8GB of RAM and an NVIDIA GeForce/AMD graphics card with a minimum of 
1GB of VRAM. For model reconstruction, OpenGL version 4.6 or higher and Vulkan version 1.2 or 
higher are required. It is recommended to update the graphics card driver to the latest version. 

 

The software supports both desktop and rack-mounted computers. It can also run on multimedia or 
gaming laptops, although performance may be significantly reduced in such cases. 

 

Our recommended running configuration is as follows: 
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●​ Memory: > 64GB 
●​ CPU: > 8 threads 
●​ Disk Capacity: > 512GB 
●​ Operating System: Microsoft Windows XP/Vista/7/8/10/Server 
●​ Graphics Card: NVIDIA GTX/Quadro series or AMD series 

 

For more professional hardware configuration advice, please contact Tiki Technologies 
(support@tiki3d.com). If the computer is configured with multiple graphics cards, the software also 
supports multi-GPU processing. 

 

Input data, processing data, and output data are best stored on fast storage devices (such as 
high-speed HDD, SSD, SAN, etc.). For file-sharing-based cluster environments, we recommend 
using Gigabit or higher Ethernet. 
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Tiki3D Master Software Installation and 
Licensing 
2.1 Installing Tiki3D Master Software 
Trial Version Users:​
You may download the latest installation package from: 

Tiki3D Website: www.tiki3d.com 

 

Full Version Users:​
Please contact Tiki Technologies support staff to obtain the latest installation package. 

 

Installation Instructions: 

Double-click the downloaded installation file to run it. 

Follow the on-screen prompts to complete the default installation. 

 

For multi-node users: ​
Please ensure that all your machines are installed with the same version of the software to avoid 
unnecessary conflicts.   

 

2.2 Tiki3D Master Software Licensing and Updates 

2.2.1 Account Registration & License Application 

Visit https://www.tiki3d.com and complete the basic information to register. 

After installing Tiki3D Master, you need to submit an authorization request to obtain a license before you can 
use the software.  

To submit a trial request:  

1.​ Open Tiki3D Activation after installation 

2.​ Fill out the Tiki3D Activation Form.  

During the first authorization, you only need to provide the following information:  

a.​ Organization name  

b.​ Name  

c.​ Mobile phone number  

d.​ Email address  

Submit the Tiki3D Activation Form.  
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3.​ Download (Right-click, click “save link”) the activation key document from your email (Check 

spam/junk folder if email is not found in inbox. 

4.​ Double-click on the activation key document (.WibuCmRaU) once and you will be prompted upon 
successful activation 

5.​ You can now open Tiki3D Master software. If you wish to check your software license, open up 
CodeMeter Control Center. 

 

2.2.2 Trial License Update 
Please contact Tiki Technologies staff (support@tiki3d.com) for trial license updates. 

 

2.3 Official Version (CodeMeter) License Configuration 
 

Tiki3D Installation and Codemeter Configuration 

During Tiki3D installation, Codemeter will be automatically installed. Open the CodeMeter Control Center after 
installation. 

 

 

License Dongle Identification: 

After inserting the dongle, check it in CodeMeter's web interface. Full version dongles have IDs formatted as 
3-*******, which differs from trial licenses.​
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The web interface displays current license expiration date and authorized connections (node count) 

Network Configuration (Two Steps): 

Step 1: Server Configuration (Dongle Host Machine) 

Navigate to: Configuration → Server → Server Access 

 

Ensure that: 

Network Server: Enabled 

CMWAN: Disabled 
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Computers on the same LAN will automatically detect the dongle license service. 

The number of concurrent connections depends on the license quantity in the dongle.​
 

Important: 

All LAN computers must disable firewalls and antivirus software 

Failure to do so may cause license access issues! 

 

Step 2: Client Machine Setup​
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To ensure client machines are properly set up, locate the license server: 

1.​ Open the web interface on the client machine 

2.​ Go to Configuration 

3.​ Remove any existing automatic server detection 

4.​ Select "Add New Server" 

5.​ Enter the host machine's IP address 

 

2.4 Official Version (CodeMeter) License Update 

2.4.1 Submitting License Update 

 

License updates for the hardware dongle are performed using update files. Follow these steps: 
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●​ Insert the dongle and open CodeMeter Control Center. 

●​ Click "License Update". 

●​ Proceed to the next step and select "Create License Request". 

●​ Export the generated license request file and send it to the manufacturer for license renewal. 

 

 

2.4.2 Importing License Update 
 

​
After receiving the update file from the manufacturer: 

●​ In CodeMeter Control Center, click "License Update" 
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●​ Select "Import License Update" this time 

●​ Import the .WibuCmRau file provided by the manufacturer 

●​ Complete the update process 
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2.5 Official Version (DeepThink) License Configuration 
During the installation of Tiki3D DeepThink Edition, the Virbox User Tool will be automatically installed. Please 
run the Virbox User Tool as an administrator. 

 

​
After inserting the hardware dongle, you can view it in the Hardware Lock interface of Virbox User Tool. The 
DeepThink Edition dongle's device information will be displayed in this interface, including the dongle case 
number, device time, and license quantity.​
 

 

​
Click "My Software" to view information such as license start time, license end time, and concurrent 
connections (node count). 

 
Tiki3D Master Software  14
 



 
 

 

 

​
When multiple machines within the same LAN need to perform parallel cluster computing, a network license 
configuration is required. On the machine with the dongle inserted, open the Virbox User Tool - Service 
Settings interface. 

In this interface, you can view the host name and host IP of the local machine. Set the service mode to 
"Client/Server Mode", click "Save & Restart", and the server-side service mode will be successfully 
configured. 

 

 

​
If software on the machine with the dongle also needs to use the licenses within the dongle, you need to add 
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the local machine's IP. After adding, the server will also occupy one license node. 

In the Service Settings interface - Server Settings, click "Add", enter the IP address, click "OK", then click 
"Save & Restart". 

 

​
When there is only one license dongle in the LAN, other nodes generally only need to set the service mode to 
Client Mode to access the server-side licenses. 

However, when multiple license dongles exist in the network, client configuration is required.  

After adding the server IP, set the service mode to "Client Mode" and click "Save & Restart". 
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After configuration is complete, you can test the connection to the service IP in the Service Settings interface. 
If the connection is successful, you can test the encrypted software.​

 

 

 

Additionally, in Advanced - License Session Tool, click "Advanced" in the upper right corner and check 
"Network Hardware Lock License Session" to view the current network hardware lock ownership and 
corresponding host names and IPs. 
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2.6 Official Version (DeepThink) License Update 
For this version's license update, you need to provide the hardware dongle case number and authorization 
period to the manufacturer. The manufacturer will then send an authorization file for license updates. 

 

After receiving the authorization file: 

1.​ Open Virbox User Tool 

2.​ Navigate to Advanced > Data Packet Upgrade 

3.​ Import the D2C format authorization file 

 

4.​ Click "Upgrade" to complete the authorization update 

5.​ After updating, you can check the authorization status in the Hardware Lock interface 
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Tiki3D Master Product System 
3.1 Tiki3D Master Main Program 
 

Tiki3D Master is the main module of Tiki3D Reality Modeling Software, primarily responsible for the following 
tasks: 

●​ Importing datasets 

●​ Defining processing settings 

●​ Submitting job tasks 

●​ Monitoring job progress 

●​ Reviewing processing results 

 

Below is the main interface of the Tiki3D Master Console. All project items can be browsed from the project 
tree:​
 

 

 

3.2 Tiki3D Engine Node Console 
Tiki3D Engine is the computing module of Tiki3D Reality Modeling Software. This module runs in the 
background without requiring interaction. When there are no computing tasks, the module automatically 
fetches and executes queued tasks, with the fetching order determined by task priority levels. A task may be 
an aerotriangulation task or a 3D reconstruction task.  
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Opening Tiki3D Engine allows you to view system information. 

To shut down the Tiki3D Engine, simply click the close button. Any running tasks will be returned to the task 
queue, with their status reverting to "Waiting" while maintaining their original priority settings. These waiting 
tasks will remain in the task sequence and will be processed when the Tiki3D Engine is restarted. 

 

3.3 Tiki3D Viewer  

Tiki3D Viewer is the viewing module of Tiki3D Reality Modeling Software. This module is a lightweight 
visualization software used to view the final results generated by the Tiki3D Master module. 
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Tiki3D Data Sources  
Manned/Unmanned Aerial Vehicle Data​
Model quality largely depends on image quality. For building areas, oblique images should generally achieve 
2-3 cm resolution; for general areas, 5-6 cm resolution is required. Photos should maintain at least 30 degrees 
of overlap coverage. 

Modeling effectiveness is unrelated to the number of cameras but depends on photo quantity and the time 
interval between adjacent flight paths.​
A nadir camera is not mandatory since true orthoimages are generated from orthographic projections of 3D 
models. Nadir cameras function similarly to other orientation cameras.​
Oblique camera angles between 20-30 degrees are optimal. Cameras set at 45-degree oblique angles 
produce images with excessively low resolution at the edges. 

 

Tiki3D Aerial Photo Modeling Data Requirements: 

●​ Continuous image overlap should typically exceed 2/3 

●​ Different viewing angles of the same object should maintain less than 15-degree separation 

 

Point Cloud Data/Image Point Cloud Fusion Data​
Point cloud data refers to a collection of vectors in a 3D coordinate system. Scanned data is recorded as 
points, each containing 3D coordinates and potentially other attribute information like color, reflectivity, or 
intensity. Typically acquired via LiDAR, cameras, or 3D scanners, this data supports 3D modeling, scene 
reconstruction, robotic navigation, VR/AR applications, etc. 

Key characteristics include high precision, resolution, and multidimensional geometric information, enabling 
accurate representation of object shapes, surfaces, and textures. Processing requires computer 
vision/graphics techniques like filtering, registration, segmentation, reconstruction, and classification. 

Commonly used LiDAR-collected point clouds offer non-contact measurement advantages: rapid acquisition, 
high precision, and accurate identification - making them essential for mobile robot navigation. Current LiDAR 
technologies primarily use triangulation or Time-of-Flight (ToF) ranging methods. Triangulation calculates 
distances by measuring laser dot positions on internal optical sensors. 

Acquisition Methods:​
Airborne, vehicle-mounted, backpack, or handheld systems​
 

Data Types: 

●​ Synchronously collected point clouds and images 

●​ Fused data from different devices 

 

Remote Sensing Satellite Data​
Satellite-mounted sensors capture comprehensive, objective surface feature data that, when processed via 
specialized remote sensing techniques, becomes georeferenced imagery. 

Satellite surveys offer unique advantages: high vantage points, broad coverage, rapid/repeatable data 
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collection, and direct digital output compatible with image processing systems. These "spaceborne eagle 
eyes" surpass traditional survey methods. 

Tiki3D Satellite Modeling Data Requirements: 

●​ Stereopair-capable multi-angle imagery of target areas (minimum 1 stereopair) 

●​ <1m resolution (sub-meter recommended for finer detail) 

●​ Minimal temporal gaps to avoid terrain-change-induced matching failures 

●​ RGB multispectral imagery for true-color representation 

●​ RPC files/parameters accompanying the imagery 
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Tiki3D Functionality 
5.1 Tiki3D Job Path Configuration 
When configuring the job path, pay attention to two aspects: 

1.​ The job path set during project submission 

2.​ The job path obtained during engine runtime 

 

For jobs to run properly, these two paths must remain consistent. It is recommended to use Engine 
Management to make changes. 

 

① Project Job Path​
The project job path can be set in two ways: 

1.​ Modify when creating a new project 

2.​ Modify within an existing project 
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② Engine Job Path 

Set in Engine Manager (refer to Online Settings) 

 

 

 

 

To access the configuration file: 

Navigate to C:\Users\Administrator\AppData\Local\Tiki 

If the AppData folder is not visible, enable "Show hidden items" in Folder View options. 

In the Tiki directory, locate the job-config.ini file to set the computer job queue directory. Simply enter the 
correct job path in the document. 

 

When the Tiki3D software engine starts, it will read these settings and begin processing jobs from the 
specified job queue directory. 
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5.2 Tiki3D Master Main Interface 
 

 

 

Common Tools Panel​
When a function is selected, its corresponding icon will be highlighted. The main functions include:  

 

​
 

✓ Texture Mode: Toggle texture display on/off 

 

✓ Display Settings: Control visibility of aerotriangulation cameras, tie points, and control points 

 

✓ Display Mode: Switch between different display states: 

●​ Point cloud display 

●​ Wireframe display 

●​ Normal display 

 

✓ Selection Mode: 

●​ Single selection mode: Click on image to select 
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●​ Box selection mode: Draw rectangle to select images 

●​ Polygon camera selection: Draw polygon to select images 

●​ Single tie point selection: Select tie point to associate with related photos 

●​ Box tie point selection: Draw rectangle to select tie point range and display associated photos 

●​ Box control point selection: Draw rectangle to select control points (deletable) 

 

✓ 3D Navigation Mode: 

●​ Fixed rotation axis mode (model rotates along fixed axis) 

●​ Free rotation axis mode (model rotates at any angle) 

 

✓ Skybox Switching: Three built-in background sky options 

 

Project Tree​
Project browsing window that manages project items through an intuitive tree structure. 

 

Properties​
Project property display interface. Shows different item attributes and project progress for management 
purposes. 

 

Photos​
Main window. Used for browsing photos and adding control points. 

 

3D View​
Browsing window. Provides POS points, tie points and 3D model viewing. Supports measurement 
functionality. 

 

Software Processing Flowchart 
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 5.2.1 Tiki3D Menu Bar 
 5.2.1.1 File 

New, Open, Save Project.​

Open Recently Used Projects.  

 

 5.2.1.2 Task 

Create Aerotriangulation Task: Create a new aerotriangulation computation task.  

 

 5.2.1.3 Measurement 

For details, refer to Section 6.3 Measurement.​
 

Coordinates  

Obtain the coordinate information of the mouse-clicked position, with the freedom to select the coordinate 
system.​
​

Distance ​
Obtain the straight-line distance and elevation difference between two points.​
​

Area ​
Obtain the surface area and perimeter of a selected region.​
The surface area is determined by the projection of the selected 3D contour onto the average plane of the 
contour points.​
​

Volume ​
Obtain the volume defined by the difference between a reference plane and the 3D model.​
The volume is determined by the sampled elevation differences between the reference plane and the 3D 
model mesh.​
Cut Volume refers to the volume of the 3D model portion above the reference plane.​
Fill Volume refers to the volume of the 3D model portion below the reference plane.​
​

Clear ​
Clear all previous measurement states. 
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 5.2.1.4 Tools 

Camera Parameters  

Manage saved camera parameters, including adding, importing, exporting, and deleting camera parameters. 

Engine Manager  

Used to manage and monitor the status of all engines, including host name, engine address, computer usage, 
project directory, task queue path, engine status, engine capabilities, cache directory, etc. Supports directly 
modifying the task queue path and configuring engine aerial triangulation in the engine management interface. 
For details, refer to Section 7.2 Engine Management. 

Image Format Conversion ​
Used for converting photos between JPG and TIFF formats. 

Photo Group Consistency Check ​
Used to check whether there are rotated photos in the photo group. If any are detected, the photos need to be 
rotated to the correct orientation. 

Specific Scenes ​
Used to store specific scenes and viewpoints. 

Language Settings ​
Used to set the software interface language. Currently supports switching between Chinese and English. 

Open Master Log ​
Click to view the file that records Master, engine-side, and browser operation events, which can help identify 
the cause of errors. 

Pop Up 3D View ​
Click to open a 3D view window that runs parallel to the Master interface. The 3D window and 2D list are 
synchronized in real time, eliminating the need to switch back and forth between 2D and 3D windows. 

Start Engine ​
Click to quickly launch the engine-side application. 

5.2.1.5 Tiki3D Toolbar  

Camera Parameters  

Obtain/Add to Camera Database – Used to store camera parameters, allowing users to customize and apply 
camera settings based on their needs. 
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Import​
Import existing camera parameter files. Currently, only Tiki3D's proprietary .bin format is supported. 

Export​
Export existing camera parameter files. Currently, only Tiki3D's proprietary .bin format is supported. 

Add​
Add existing camera parameter files to the camera library. 

Usage Instructions: 

1.​ Click "Add" and manually enter the parameters from the camera report into the corresponding fields 
in Tiki3D's camera parameter settings.​
​
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a.​ Fill in all available parameters; leave unspecified fields as default. 

b.​ Set a Camera Name for identification. 

c.​ Click "OK" to save the new camera parameters to the library. 

d.​ Repeat the process for different lenses. 

2.​ To apply camera parameters:  

a.​ Right-click on the desired photo group and select "Import Camera Parameters." 

 

b.​ From the camera library, choose the appropriate parameters for the photo group and click 
"OK" to confirm. 
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c.​ After importing, verify the settings in the photo group’s properties panel. 

 

Engine Manager  

Engine Manager is used to monitor Tiki3D Engine usage in real time and dynamically allocate engine 
resources. 

 

Figure 51 

The Engine Manager interface supports batch management of all engines and allows direct modification of 
the engine working path. 

●​ Right-click on the corresponding engine → Modify Job Path, then change it to the path where the 
job tasks are located. 
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​
Figure 52 

​
Figure 53 

Task Lock Types 

●​ Folder Lock 

●​ Distributed Lock 

File Lock vs. Directory Lock (Folder Lock) 

●​ For standard Windows file systems, use the default File Lock. 

●​ For special file systems (e.g., NAS servers), try Folder Lock. 

Note on Directory Lock Scope: 

●​ The Folder Lock applies to the Job System task queue path. 

●​ When setting a Folder Lock for the first time on a task queue path: 

o​ Do not start the Engine immediately. 

o​ Wait until the Master finishes the configuration before launching the Engine. 

●​ Upon startup, the Engine will display whether it is using File Lock or Folder Lock—ensure the 
correct type is selected. 

 

After the modification, the engine interface will automatically switch to the target path. 
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​
Figure 55 

Task Types 

Tiki3D Engine fetches two types of tasks: 

●​ Aerotriangulation (AT) Task: Created by submitting an AT block. 

●​ Reconstruction Task: Created by submitting a reconstruction production project. 

Task Sequence 

Tiki3D Engine retrieves tasks for processing from the task sequence folder under the task queue path. The 
task sequence folder contains the following subfolders: 

​
Figure 56 

●​ Canceled: Contains tasks canceled by the user. 

●​ Completed: Contains successfully finished tasks. 

●​ Nodes: Contains all engine nodes associated with the current task path. 

●​ Failed: Contains tasks that failed during processing. 

●​ Pending: Contains tasks waiting to be processed. This subfolder includes three priority-level 
subfolders: Low, Medium, and High, indicating task priority. 

●​ Running: Contains tasks currently being processed. 

The task sequence can be managed directly via Windows File Explorer: 

●​ Cancel a waiting task: Move the task file from Schedule (Low/Medium/High) to Canceled. 
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●​ Cancel a running task: Move the task file from Running to Canceled. 

●​ Change task priority: Move the task file between Scheduled (Low/Medium/High). 

●​ Restart a task: Move the task file from Canceled or Failed to Running. 

●​ Clear failed or canceled tasks: Delete task files from Failed or Canceled. 

●​ Clear completed tasks: Delete task files from Completed. 

Setting Engine Capabilities 

During parallel AT computation, Tiki3D randomly selects a host for the adjustment step. To ensure 
high-performance machines handle critical calculations, the software allows configuring engine capabilities 
per node, restricting engines to specific functions. 

In the Engine Manager interface, right-click the target engine and select Set Engine Capabilities. 

​
Figure 57 

The engine capabilities (A, F, Mt, M, B, Re, Ra) correspond to: 

●​ A: AT Creation 

●​ F: Feature Extraction 

●​ Mt: Image Similarity Calculation 

●​ M: Feature Matching 

●​ B: Bundle Adjustment 

●​ Re: 3D Reconstruction 

●​ Ra: Raster Operations 

Unchecking a capability prevents the engine from executing that step. 

●​ Image Similarity Calculation (Mt) and Bundle Adjustment (B) are single-machine computations; 
others support clustering. 

●​ Bundle Adjustment requires significant memory. Low-memory hosts should disable this option to 
avoid out-of-memory errors. 

Pause/Resume 

Pauses or resumes tasks on the current node. 

●​ Pause: Stops the currently running task, which is automatically returned to the task queue. 

Specific Scenes ​
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Stores camera positions and orientations of a 3D scene for quick viewpoint restoration. 

 

●​ To add a scene: Import coordinates from measurements.  

​
Figure 58* 

●​ To use: Double-click a saved scene to instantly switch to its viewpoint. 

5.2.1.5.1 Displaying and Exporting Log 

Display Error Log​
When issues occur during aerotriangulation (AT) and modeling, you can quickly locate calculation errors by 
displaying the error log. 

To view the log, right-click on the failed AT task or tile and select "Show Log." If you are unable to determine 
the cause of the error, you can send a screenshot of the log to technical support for assistance. If the log 
cannot be displayed, you can choose to export the log file to seek technical support. 

Export Log​
If displaying the log does not help identify the error, the technical support team may request the user to export 
the calculation log file. Users can choose to export the log to seek technical support. 

Note: The log file cannot be opened or viewed locally. Users need to provide it to our technical support team 
for analysis. 

Method: Right-click on the failed AT task and select "Export Log." The software will package the relevant log 
files into a compressed archive, which the user can then provide technical support for assistance. 

 

5.2.1.5.2 Coordinate File Modification 

During data processing, it is often necessary to customize a coordinate system. The steps to create a custom 
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coordinate system file are as follows. 

1.​ Obtain a Similar .prj File​

First, acquire a .prj file that closely matches the target coordinate system. You can export one from 

Kanjing Smart3D by right-clicking on a coordinate system with a similar ellipsoid and central 

meridian. This file will serve as a base for further modifications. 

2.​ Modify Ellipsoid and Projection Parameters​

Adjust the ellipsoid and projection parameters by editing the fields highlighted in red in the file. 

 

 

 

 

 

 

Figure 60​

The image shows a modified coordinate file where the central meridian has been updated. Save the changes 

in .prj format. 

3.​ .prj File with Seven-Parameter Transformation​

When using a local urban coordinate system, you may need to include the corresponding 

seven-parameter transformation in the file. 

a.​ Add a line in the following format: 

TOWGS84[dx, dy, dz, rx, ry, rz, scale] 

where: 

i.​ dx, dy, dz = Coordinate shifts (translation) 

ii.​ rx, ry, rz = Rotation angles (in arc-seconds) 
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iii.​ scale = Scale factor (in parts per million) 

Example: 

TOWGS84[100, 200, 300, 1.5, 2.5, 3.5, 0.999999] 

Save the modified file in .prj format for use in your project. 

5.2.1.5.3 Texture Mapping Enhancement Tool 

If texture distortion occurs in a specific tile of the 3D model, you can optimize it by selecting the tile and 

enabling the "Visibility Detection" option under "Reset Task" with the "Enhanced" setting. 

Steps:​

1. Select the problematic tile in the model.​

2. Right-click and choose "Reset Task."​

3. Set "Visibility Detection" to "Enhanced" for optimization. 

This process helps correct texture misalignment and improves visual quality. If issues persist, further manual 

adjustments or reprocessing may be required 
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5.2.2 Tiki3D Master Project Tree 
 5.2.2.1 Project Name 
The Project function is used to manage project-related information, including project and project paths, image 
path updates, and importing aerotriangulation (AT) data. A detailed description of the project can be entered in 
the Project Info section. 

Modifying Project Path 

The project path can be modified within the project. 

 

Importing Aerotriangulation (AT) Data 

New projects support importing AT files in: 

●​ Universal formats (e.g., .xml) 

●​ Tiki3D proprietary format (.at) 

Multiple AT files can be imported in a single operation. 

 

 

Opening the Resource Manager 

Right-click on the project and select Resource Manager to access the Image Source Management 
interface. 
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Updating Path Status 

●​ Use Update Status to check the accessibility of all images in the list. 

o​ Accessible paths (correct) require no changes. 

o​ Inaccessible paths (marked as "Not Found") must be corrected. 

 

Modifying Incorrect Paths 

1.​ Double-click a path to copy it. 

2.​ Select Replace Path. 

a.​ In Find, paste the incorrect path. 

b.​ In Replace with, enter the correct path. 

3.​ Click Replace to confirm. 
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4.​ After all corrections, click Update Status again to verify all paths. 

5.​ Click Apply Update to save changes. 

Exporting a Project 

  

 

Export the project as a compressed file, with optional inclusions: 

●​ AT results 

●​ Reconstruction results 

●​ Temporary directories 

 

Deleting Cache Files 

 

Clears temporary files generated during processing with a single click. Cache files include: 
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●​ AT cache files 

●​ Reconstruction cache files 

⚠ Note: Deleting cache files will require reprocessing from scratch. 

 

Modifying Task Queue Path 

 

 

The task queue path can be set in two ways: 

1.​ During project creation. 

2.​ Within an existing project. 
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5.2.2.2 Original Photos 
5.2.2.2.1 Photo Groups 

 

Photo Groups are used to manage one or multiple sets of images and their attributes. 

Creating a New Photogroup 

Create a new photogroup to add images. 

Importing Photos 

●​ Add Photo Selection, support multiple-selection (Shift) or select all (Ctrl+A). 

●​ Import all supported image formats from the selected folder. 

Importing Photogroups 

●​ When importing all images from a directory, they are automatically assigned to different photo groups 
based on their folder structure, with the group name matching the folder name. 

●​ If images within the same folder have different attributes (e.g., camera parameters, image 
dimensions), they will be automatically sorted into separate groups. 

Importing POS Files 

●​ Import image positioning and orientation data from a file. 

●​ Requirement: Image names within the photo group must be unique. If duplicates exist, use the 
method of assigning a POS file to each photo individually. 

Importing Excel Files 

●​ Import an Excel (.xlsx) file to retrieve image and related metadata. 

Importing Videos 

●​ Import video file paths and set a frame extraction interval. The software will extract keyframes for 3D 
model generation. 

●​ Supported formats: .mp4, .wmv, .avi, .mov, and .flv. 
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Exporting BlockExchange 

●​ Export an aerotriangulation (AT) file containing only the original image data, POS information, and 
camera parameters. 

●​ Supported formats: 

o​ .at format (Tiki3D proprietary, recommended for faster import/export and smaller file size). 

o​ .xml format (universally compatible with third-party software). 

Check Image Path 

●​ Verify the correctness of image paths in the photo group. Two modes are available: 

o​ Quick Check – Verifies only if the images exist (faster, does not check for corruption). 

o​ Deep Check – Validates image integrity (slower but detects damaged files). 

●​ If invalid or corrupted paths are found, they can be deleted in bulk from the report or corrected via the 
Resource Manager. 

 

Set Photogroup Directory 

●​ Reassign the photo group directory. It is recommended to modify image paths via the file explorer. 

Deleting Rotation Data 

●​ Remove image rotation (attitude) information while retaining position data. Useful when rotation data 
is incorrect. 

Deleting Position and Rotation Data 
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●​ Clear all position and rotation information from the images. 

5.2.2.2.2 Partition Reference Points (Control Points) 

Adding Control Points 

●​ Add individual control points manually. 

Importing Control Points 

●​ Import control point files in TXT/CSV format. 

Importing BlockExchange Format Control Points 

●​ Supports importing control point files in XML format exported from ContextCapture software. 

Importing Tiki3D Control Points 

●​ Supports importing control point files in XML format exported from Tiki3D software. 

 

5.2.2.2.3 Photo Block Division 

When processing large datasets, operators often need to divide photos into blocks. Tiki3D supports direct 
block division and merging of large-area data within the software. 

Creating a New Photo Block 

1.​ Photos are displayed in the 3D interface. Under Original Photos in Tiki3D, right-click Photo Block 
Division and select Create New Block. 

a.​ Note: All photos must have POS data. Photos without POS information cannot be selected 
for blocking. 

 

2.​ Rename the new block (e.g., "Block 1-1") and select a display color. Click Next.​
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3.​ Rotate the 3D view by holding the left mouse button to adjust the perspective for data selection. 

Selecting Photos for Blocking 

●​ In the 3D view, click Select Photos to choose POS data. 

●​ Selection Methods: 

o​ Rectangular selection 

o​ Polygonal selection (switch modes in the selection toolbar)​

 

●​ Hold Shift + Left-Click to rotate the current view. Selected photos appear in the right panel, with the 
count displayed in the top-left corner. 
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4.​ Click Finish to create the new block. 

Dividing Remaining Data 

●​ Repeat the process to divide the remaining data into blocks. 

●​ Key Considerations: 

o​ Maintain overlap between adjacent blocks. 

o​ Ensure overlapping areas contain at least three control points. 

Aerotriangulation (AT) for Divided Blocks 

●​ When multiple blocks are created, you can run AT on individual blocks.​
(Refer to Figures 76 & 77) 

 

 

Merging Blocks 

1.​ After completing AT for all blocks, merge them into a single AT task: 

a.​ Right-click the selected AT tasks and choose Merge.​
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2.​ Color Consistency Adjustment: 

a.​ Merged blocks may exhibit color differences. Tiki3D provides color harmonization to ensure 
tonal uniformity across the entire survey area. 

b.​ Right-click the merged AT task and select Color Consistency Adjustment to apply 
corrections. 

 

5.2.2.3 Point Cloud Collection 

The point cloud import function supports importing both static point clouds and dynamic point clouds. 
These can be integrated with aerial images for combined 3D reconstruction or used independently for 
point-cloud-based modeling. 

 

Importing Static Point Clouds 

●​ Definition: Point clouds captured when both the object and scanning device are stationary (e.g., 
tripod-mounted laser scanners). 

●​ Supported Formats: E57, LAS, PLY. 
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Importing Dynamic Point Clouds 

●​ Definition: Point clouds captured while the scanning device is in motion (e.g., backpack, handheld, 
airborne, or vehicle-mounted scanners). 

●​ Supported Formats: E57, LAS. 

●​ Requirement: Trajectory files must be provided for processing. 

Adding Point Clouds to Aerotriangulation (AT) 

●​ Merge point cloud data with photo-based AT results for integrated 3D reconstruction. 

Creating a Reconstruction Task 

●​ Perform point-cloud-only reconstruction, where geometry and textures are derived solely from the 
point cloud data. 
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5.2.2.4 Aerotriangulation Task 
5.2.2.4.1 AT Task Options 
After submission, AT tasks display the following actions: 

 

Operational Options: 

●​ Start Processing: Begin AT processing. Settings can be adjusted in the pop-up dialog. 

●​ Cancel Job: Terminate the AT task. 

●​ Clone AT Task: Duplicate the task for modifications without altering the original. 

●​ Clone AT & Update Source Data: Duplicate the task and refresh image data if the photogroup is 
updated. 

●​ Delete AT Task: Remove unnecessary tasks. 

●​ Unload AT: Reduce memory usage by unloading (data remains stored; reload to resume). 

●​ Refresh AT: Update task info if display errors occur. 

●​ Rename: Modify the task name (no impact on calculations). 

●​ Set AT Results as Metadata (POS Data): Copy the task and assign computed positions as initial 
data for a new AT run. 

●​ Show/Rebuild AT Report: Check or update the accuracy report. 

●​ Export AT: Save AT outputs in .xml format. 

●​ AT image point cloud fusion 

●​ (Compute Color Correction) Color Consistency Adjustment: Harmonize color discrepancies 
between merged AT blocks. 

●​ Export Debug File: Export debugging files for software troubleshooting. 

●​ Export Log: Generate logs for technical analysis if AT fails. 

●​ Show Error Log: Review processing details to diagnose AT failures. 
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5.2.2.4.2 AT Task Properties 

The properties panel displays submission parameters and real-time attributes: 

 

Key Attributes: 

●​ Task Name: Editable label. 

●​ Task ID: Unique identifier (non-editable). 

●​ Status: Progress bar. 

●​ Current Phase (Job Info): Active processing stage. 

●​ Feature Density: Tie point density selected for AT. 

●​ Dense Matching Mode: Cluster or standalone computation. 

●​ Pair Selection Mode: Method for selecting image pairs. 

●​ Data Source: Full photo set or specific blocks. 
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●​ Reference Camera: Camera model used. 

●​ Position Mode 

●​ Tie Points/Position/Rotation/Focal Length/Principal Point: Calculation methods for respective 
parameters. 

●​ Lens Distortion: Radial/tangential distortion models. 

●​ Aspect Ratio/(Skew) Angle: Sensor calibration settings. 

●​ Down Sampling (Factor): Image resolution reduction ratio. 

●​ Data Type: Input data category. 

●​ Texture Type: Texture handling options. 

●​ AT Mode: Processing configuration. 

●​ Reuse Match Cache: Optimization for repeated calculations. 

●​ Color Correction (Consistency): Toggle for color harmonization. 

●​ Tie Point Size: Display scale for 3D tie points. 

 

5.2.2.5 Reconstruction Task 

5.2.2.5.1 Reconstruction Task Options 

The reconstruction task options are shown below: 

 

Available operations for reconstruction tasks: 

●​ Start Processing: Begins the reconstruction process. A dialog box will appear after submission, 
allowing for setting adjustments. 

●​ Cancel Job: Terminates the reconstruction task. 

●​ Clone Reconstruction: Duplicates an existing reconstruction task. 
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●​ Delete Reconstruction: Removes unnecessary reconstruction tasks. 

●​ Rename: Renames the current reconstruction task without affecting project calculations. 

●​ View (Show) Reconstruction Report: Displays the reconstruction results report. 

●​ Export Tile Boundaries: Exports boundary lines for all tiles, including: 

o​ Completed tiles 

o​ Failed tiles 

o​ Pending tiles 

o​ Unsubmitted tiles​
​

 

●​ Modeling Management 2: Refreshes AT task information. If data display is incorrect, this function 
reloads the AT task for proper visualization. 

●​ Publish Results: Supports export in multiple formats: 

o​ OSGB, OBJ, DAE, 3DTiles, 3MX, LAS 

o​ Esri i3S, SuperMap S3M, FBX 

o​ Google Earth 3D KML 

o​ DOM/DSM 

●​ Generate OSGB Index: Creates an index file for quick model access. 

 

5.2.2.5.2 Reconstruction Task Properties 

The properties panel displays all parameters set during reconstruction submission. For detailed parameter 
descriptions, see Section 5.3.5.1: Reconstruction Parameter Settings. 
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Key Features: 

●​ Centralized view of reconstruction configuration 

●​ Direct access to parameter documentation 

●​ Real-time verification of processing settings 

5.3 Tiki3D Master Workflow Guide 

 5.3.1 Creating a New Project 
1.​ Open Tiki3D Master. 
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2.​ Click File → New Project or the New Project icon . 

3.​ Enter a project name and specify: 

a.​ Project Path 

b.​ Job Path 

4.​ Click Confirm. 

 

Job Path Notes: 

●​ Stores task runtime files (small size but requires high disk I/O speed). 

●​ Defaults to C:\; recommended to use an SSD (avoid storing on the same disk as the project). 

Project Structure (Post-Creation): 

●​ Project Name: Represents a single dataset but supports multiple AT/reconstruction tasks. 

●​ Photogroups: Interface for creating/importing photos, POS data, and editing camera parameters. 

●​ AT Tasks: Perform calculations, add control points, and review adjustment reports. 

●​ Reconstruction Tasks: Generates textured 3D mesh models after successful AT. 

 5.3.2 Image Loading 
After project creation, import: 

●​ Images 

●​ POS data 

●​ Camera parameters 

Three Import Methods: 

1.​ Import Photos (Slow but verifies integrity; generates thumbnails). 

2.​ Import XML AT File (Fast but requires manual photo validation). 

3.​ Import Excel Sheet (Fast but lacks auto-validation). 

 

 
Tiki3D Master Software  56
 



 
 

 
 5.3.2.1 Importing Photos 

Right-click Photogroup → Add Photo Selection or Add Entire Directory (shown below). 

 

Options: 

●​ New Photogroup: New group setup. 

●​ Add Photo Selection: Single/multiple images. 

●​ Add Entire Directory: Entire folder (auto-organizes by subfolder names). 

●​ Import Photo from Video Screenshot: Single/multiple images from video clip. 

●​ Import POS (csv, txt): Matches POS data to images (1:1 required). 

●​ Import POS (xls, xlsx): Bulk import via formatted .xlsx. 

●​ Import Video: Extracts keyframes (supports .mp4, .wmv, .avi, .mov, .mpg, .flv). 

o​ Set extraction interval/output directory. 

​
 

●​ Export BlockExchange: Generates .xml with images, POS, and camera data (no tie points). 

●​ Check Image Paths: Validates paths; use Path Manager to fix errors. 

●​ Set Photogroup Directory: Reassign paths (bulk or individual). 
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●​ Delete Rotation(s): Removes orientation-only. 

●​ Delete Position(s) & Rotation(s): Clears all POS data. 

GNSS Height Reference: 

●​ If images lack geotags → Ignore. 

●​ If geotagged → Select ellipsoid/vertical datum. 

 

 

5.3.2.2 Importing POS Files 

Right-click Photo Group → Import POS. 

 

Modes: 

1.​ Single POS File: Covers all photos (no duplicate names allowed). 

2.​ Per-Group POS Files: Individual files for each group. 

Steps: 

1.​ Select a delimiter and skip header lines (if any). 

​
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2.​ Choose the coordinate system (default: WGS84). 
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3.​ Enable Import Camera Attitude if available (set angle format).​

​

 

4.​ Map columns to fields (ensure correct order). 

​
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View POS Data: Toggle display via red-circle button. 
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(Refer to Figures 93–94) 

 

 5.3.2.3 Importing Camera Parameters 

1.​ Open Camera Parameters from toolbar.​

 

2.​ Click Add → Enter values from calibration report (unlisted = 0). Name the preset.​
(Refer to Figures 96–97) 

​
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Save/Load Parameters: 

●​ To Library: Right-click photo group → Add Camera Model to Library. 

​
(Refer to Figure 98) 

●​ From BIN/OPT File: 

o​ Right-click group → Import Camera Parameters (bin/opt). 

o​ Select preset → Confirm. 
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​
(Refer to Figures 99–100) 

 

 5.3.2.4 Importing XML AT Files 

Right-click project → Import AT File (.xml). 

●​ Note: Only for blank projects. 

●​ Drag/drop files; multiple imports auto-merge.​
(Refer to Figures 101–102) 

​
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 5.3.2.5 Importing Excel Files 

Supports .xlsx with structured worksheets: 
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Worksheets: 

1.​ Photo Groups: 

a.​ Required: Name, Width/Height (pixels), Focal Length (mm), SensorSize (mm). 

b.​ Optional: Principal Point offsets (pixels/mm), lens distortion (K1–K3, P1–P2). 

2.​ Images: 

a.​ Required: Filename, linked PhotoGroup Name. 

b.​ Optional: Directory, Extension, coordinates (Long/Lat/Height or E/N/H), angles 
(Omega/Phi/Kappa or Heading/Roll/Pitch). 

3.​ Control Points: 

a.​ Avoid adding here; use XML for image-linked points. 

4.​ Options: 

a.​ Coordinate system (EPSG/PROJ.4/WKT). 

b.​ Root directory (for constructing absolute paths). 

c.​ Block type (optional). 

 

 5.3.3 Point Cloud Loading 

When point cloud data is involved in reconstruction, both static and dynamic point clouds can be imported 
and processed as described below. 

 

 5.3.3.1 Importing Static Point Clouds 

Import scanned point cloud data in the following formats: LAS, E57, PLY. 

(Refer to Figure 105) 

Configuration Options: 

●​ Point Cloud File Path: 
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o​ Specify the input path. Supports batch import of multiple files (E57, LAS, PLY). 

●​ Transformation File Path: 

o​ Used with point cloud splitting to save subdivided data. 

●​ Point Cloud Splitting: 

o​ Splits large datasets into smaller chunks to reduce hardware load and prevent lag. 

●​ Simplified Display: 

o​ Optimizes rendering for smoother visualization. 

●​ Coordinate System Selection: 

o​ Must match the point cloud's native CRS. Default: WGS84. Other systems available via 
dropdown. 

 5.3.3.2 Importing Dynamic Point Clouds 

Import scanned point cloud data in LAS or E57 format. 

 

 

 

 

 

 

 

(Refer to Figure 106) 

Requirements: 

●​ A trajectory file is mandatory, containing: 

o​ GPSTime, Latitude, Longitude, H-Ell (ellipsoidal height).​
(Refer to Figure 107) 

Steps: 

1.​ Confirm the delimiter and preview column mapping.​
(Refer to Figure 108) 

2.​ Select the point cloud’s coordinate system.​
(Refer to Figure 109) 
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3.​ Map data fields and complete the import.​

(Refer to Figure 110) 

 

 5.3.3.3 Adding Point Clouds to Aerotriangulation 

Merge imported point clouds with a selected AT task for integrated reconstruction. 

(Refer to Figures 111–112) 

Result: 

●​ The AT task will include both: 

o​ Photo Group (image data) 

o​ Point Cloud Set (scanned data). 

 

 5.3.3.4 Creating Reconstruction Tasks 

1.​ Right-click the Point Cloud Set → Create Reconstruction Task. 

2.​ Select point clouds to include and confirm.​
(Refer to Figure 113) 

3.​ Configure parameters in the pop-up window (see Section 5.3.5.1 for settings).​
(Refer to Figure 114) 

 

 5.3.4 Tiki3D Master Aerotriangulation 

 5.3.4.1 Submitting Aerotriangulation Tasks 

After importing the POS, right-click on the aerotriangulation task and select "Create AT Task" to create a new 
aerotriangulation task. Enter the name of the aerotriangulation task.  

In the reference camera selection, check the NADIR camera as the reference camera.  

If using cluster parallel computing, ensure that the image path, project path, and Job path are all using 
network paths. 
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Reference Camera  

This is a new aerotriangulation algorithm. If not selected, the general aerotriangulation algorithm will be used. 
Selecting this can significantly improve the performance of the aerotriangulation. When selecting, you need to 
specify a reference camera that can cover all survey areas. For multi-view oblique aerial photography data, 
the NADIR camera can be selected as the reference camera. When submitting the aerotriangulation 
calculation, the default settings of the software are sufficient to handle most image data. It is recommended to 
submit with the default settings for the first run. Below are the relevant aerotriangulation settings parameters. 
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Calculate Only Tie Points 

During aerotriangulation, only tie points are included in the calculation, performing a free network 
aerotriangulation. Control points (GCPs) do not participate in the adjustment solution. 

Positioning Mode 

●​ Unreferenced Aerotriangulation: Without positioning information, the position and orientation of the 
block are unrestricted. 

●​ Automatic Vertical Downward: The vertical orientation of the block is determined by the composite 
vertical direction of the images involved in the calculation. This option is used when the positioning 
information is inaccurate during aerial photography. 

●​ High Precision Position/Altitude Assisted Adjustment (<0.10 meters): Used when GNSS/POS 
positioning accuracy is high. Using GNSS/POS in the adjustment requires that each image has 
precise position information with an error of <0.1 meters. 

●​ Low Precision Position/Altitude Assisted Adjustment (<10.0 meters): Used when GNSS/POS 
positioning accuracy is slightly lower, with positioning errors needing to be <10 meters. 

●​ Conventional Position/Altitude Rigid Transformation: Adjusts the block positioning using image 
GNSS/POS data, with no high requirements on positioning accuracy. 

●​ Use Control Points for Bundle Adjustment: Control points participate in the adjustment, providing 
precise positioning of the block. 
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●​ Use Control Points Rigid Transformation: Uses reference control points for rigid registration of the 

block without correcting geometric distortions, used when control points are not precise (generally not 
used). 

 

Camera External and Internal Parameter Calculation Methods 

●​ Calculate: All parameters are recalculated. 

●​ Adjust: Uses the input values as initial values for calculation. 

●​ Keep: Uses the input values as precise values and does not perform further calculations. 

 

Tie Point Density  

Adjusts the density of tie points extracted during aerotriangulation matching. 

●​ Normal: Suitable for most data (the default option). 

●​ High: Suitable for data with weak textures or small images, increases the number of tie point 
matches, but also increases the computation time for aerotriangulation. 

 

Color Consistency Adjustment (Inter-tile Color Fusion) 

●​ Enable: The software automatically performs color balancing on all images. 

●​ Disable: The software does not automatically perform color balancing on images. 

 

(Downsampling) Sampling Factor  

Mainly used for the generation of single-lens photo quick mosaics. The higher the sampling factor, the fewer 
tie points are extracted, and the lower the image resolution. 

 

Match Pair Selection Mode 

●​ Default: Suitable for most data, the default option. 

●​ Enhanced (Intensify mode?): If the images mostly consist of weak or no texture areas, and there are 
many lost images after aerotriangulation, it is recommended to choose the enhanced match pair 
selection mode. 

 

Reuse Match Cache (New feature) 

●​ … 
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After selecting the aerotriangulation settings, click "Next". If "Auto Submit AT_Task" is checked, the 
calculation will start directly after clicking "Finish". If not checked, the calculation will not start immediately after 
clicking "Complete", and you will need to click "Submit Reconstruction" again for the software to start the 
calculation. 

”Auto Reconstruction” checkbox: 

 

 

 

 

AT Modes: 

●​ Balanced Mode: Suitable for general aerial image triangulation processing. This is the default option. 
A computer with 64GB RAM can process 15,000 to 20,000 images, while a computer with 128GB 
RAM can process 40,000 to 60,000 images. With “Enhanced Balanced Mode” 

 
Tiki3D Master Software  72
 



 
 

 
●​ Performance Mode: Suitable for large-scale data triangulation processing. A computer with 64GB 

RAM can process 40,000 to 50,000 images, while a computer with 128GB RAM can process 100,000 
images. With “(Faster, for dataset < 100000 images)” 

●​ Performance Mode (Enhanced): Supports larger data volumes with the same memory capacity. A 
computer with 64GB RAM can process 100,000 images. 

●​ Capacity Mode: Suitable for large-scale data triangulation without chunking. This mode uses 
chunked triangulation adjustment followed by joint adjustment and does not allow merging data from 
multiple flights. It is recommended for tasks with more than 100,000 photos. A computer with 64GB 
RAM can process 100,000 to 200,000 photos in a single triangulation process. 

 

After submitting the computation, you need to open the Engine Manager of the software to start the 
computation. Ensure that the Job Path in the Engine Manager matches the path selected when creating the 
project. The Job Path can be modified in the engine management by right-clicking and submitting the 
changes. During the triangulation calculation, you can view the progress bar in the properties panel. 

 

  

Matched POS points are displayed in orange, while unmatched POS points are displayed in yellow. 

Operations Available for Each Aerotriangulation (AT) Task: 

●​ Start Processing: Initiates the AT computation. A dialog box will appear after submission, allowing for 
adjustments to settings. 

●​ Cancel Job: Terminates the ongoing AT computation task. 

●​ Clone AT: Duplicates an existing AT task. Useful if modifications are needed without altering the 
original AT results. 

●​ Clone AT & Update Source Data (Photogroup): If the imported photo group has been updated, this 
creates a new AT task with refreshed image data. 

●​ Delete AT: Removes unnecessary AT tasks. 

●​ Unload AT: Reduces project memory usage and speeds up data loading by unloading the AT task 
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(data remains stored). The task becomes inactive but can be restored via loading. 

●​ Refresh AT: Updates AT task information. Use this if displayed data appears incorrect. 

●​ Set AT Results as Metadata (POS Data): Copies an AT task and assigns the computed positional 
data to photos, which then serve as the initial reference for a new AT computation. 

●​ Export AT Results: After AT completion, results can be exported in .xml format. 

●​ Show AT Report: Displays the AT accuracy report. 

●​ Rebuild AT Report: Updates the displayed AT report. 

●​ Export Log: Generates a log file documenting the AT process. Useful when standard methods fail to 
diagnose AT failures; logs can be shared with technical support for analysis. 

●​ Rename: Renames the current AT task without affecting project computations. 

●​ Compute Color Correction (Consistency): Reduces color discrepancies between merged AT blocks 
during multi-block modeling. 

●​ Export Debug File: Exports project debugging files for software vendor analysis. 

●​ Show Error Log: Shows the AT processing details when a task fails, aiding in quick error diagnosis. 

●​ Export Logs (Alternative): If error logs are insufficient for diagnosing AT failures, logs can be 
exported and sent to technical support for further analysis. 

●​ Unload/Load (Reiterated): Unloading an AT task reduces memory usage and improves loading times 
without deleting task data. The task can be reloaded when needed. 

 

Figure 121 
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5.3.4.2 Viewing Aerotriangulation Reports 
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Quality Report 

Calibration Data Volume and Homologous Tie Points 

●​ Check the volume of calibration data and the number of homologous tie points. 

 

Mean Reprojection Error 

●​ Review the mean reprojection error, which should be less than 1 pixel. 

●​ For manned aerial data, the mean reprojection error should be < 0.6 pixels. 

●​ For unmanned aerial data, the mean reprojection error should be < 1 pixel. 

 

Control Point/Check Point Errors 

●​ In the control point list, review the residuals and mean errors of control points or check points. 

●​ The RMS error of control points should generally be less than 1 pixel. 

 
Tiki3D Master Software  77
 



 
 

 
●​ The RMS error of check points should be less than 2-3 pixels. 

 

 

5.3.4.3 Import Custom Coordinate System 

Tiki3D supports importing custom coordinate system files through the following steps: 

Method 1: Modify Existing PRJ File 

1.​ Navigate to:​
World Coordinate Systems → More → Spatial Reference System Database 

2.​ This displays all built-in coordinate systems (stored as .prj files). 

3.​ Modify an existing .prj file based on your coordinate data (see Section 7.7 for editing guidance). 

4.​ After modification, import the updated .prj from the Spatial Reference System Database.​
(Refer to Figure 126) 

Method 2: Add a New Custom System 

1.​ Scroll to the bottom of the database and select User-Defined Coordinate Systems → Define New 
System. 

2.​ Click Browse Coordinate System File to import the desired .prj file. 

3.​ Click Add to Library to store it under User Defined Systems. 

4.​ To remove a system, select it and click Remove from Library.​
(Refer to Figures 127–128) 
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Custom ENU Coordinate System 

1.​ Click Define New System. 

2.​ Under Name and Definition, input in the format: 

ENU: [Latitude], [Longitude]   

(Example shown in Figure 129) 

3.​ Click Add to Library to save the ENU system. 

 

 

 

 5.3.4.4 Adding/Importing Control Points 

After completing the aerotriangulation (AT), it is necessary to add control points. To perform this operation, you 
must first duplicate the AT task, as editing is only allowed on a copied task. 

 

1.​ Importing Control Points 

●​ Right-click on the control point information and select "Import Formatted Text Control Points". 

●​ Choose the control point file and open it. 

 

2.​ Coordinate System and Field Assignment 

●​ The process of importing control points is similar to importing POS data. 

●​ Select the correct coordinate system. 

●​ Assign the appropriate fields to the control points. 

 

3.​ Completion 
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●​ Click "Finish" to complete the import process. 

 

This ensures that the control points are correctly integrated into the project for further processing. 

 

 

 

Selecting the Control Point Coordinate System 

 

When assigning field attributes to each column, pay attention to the order of the XY values. In commonly used 
coordinate systems: 
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●​ A 6-digit length typically represents the X value. 
●​ A 7-digit length typically represents the Y value. 

Ensure the correct assignment to maintain data accuracy. 

 

After importing, you can review the control points in the control point list. The list displays the error statistics 
for all control points. 

 

 

After the control points are imported, they are displayed in a list format. 

Additionally, you can view them in the 3D interface. In the interface: 

 

●​ Red markers indicate points that have not been measured. 

●​ Green markers represent completed control points. 

●​ Yellow markers denote check points. 

 

 

When marking points, click on a control point and locate its match in the photo interface. Here, you can see 
the images where the software predicts the control point is located. Click on one of the photos to start marking 
the point. 
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 5.3.4.5 Tie Point Selection and Adjustment 

Marking Control Points: 

1.​ Click on a control point in the interface to view software-predicted photo locations. 

2.​ Select a photo to begin marking (pinning). ​
 

​
Figure 140 

Marking Interface Controls: 

●​ Mouse wheel: Zoom in/out 

●​ Left mouse button: Pan image 

●​ Visual indicators: 

o​ Yellow cursor: Unrecorded point 

o​ Shift + Left click: Confirm marking (point turns red upon confirmation) 

o​ Right-side panel displays marked photos 

Photo Status Colors: 

●​ Red: Predicted point at photo edge 

●​ Green: Predicted point near photo center 
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●​ Yellow: Intermediate position 

Epipolar Line Display: 

●​ Green epipolar lines appear (transparent) 

●​ Press "V" to toggle visibility 

Marking Requirements: 

●​ Mark points in all camera groups 

●​ Minimum 3 photos per lens group 

●​ Require ≥4 control points before submitting adjustment  

​
Figure 141 

Check Point Usage: 

●​ Scroll to bottom of control point list 

●​ Checkbox in last column designates check points 

●​ Check points: 

o​ Excluded from adjustment 

o​ Generate error reports in AT output (Refer to Figure 142) 

Adjustment Options: 

1.​ Control Point Adjustment (Recommended): 

a.​ Full geometric registration using control points 

b.​ Default parameters suggested 

2.​ Rigid Transformation (Not Recommended): 

a.​ Basic alignment only 
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b.​ No long-range geometric correction 

Post-Adjustment: 

●​ Always review AT quality report after computation 

●​ Verify accuracy metrics before proceeding 

 

 5.3.4.6 Exporting Aerotriangulation Results 

Right-click on the AT task and select Export AT Results. 

 

Supported Export Formats: 

1.​ .at Format (Recommended) 

a.​ Tiki3D's proprietary format for internal AT data transfer 

b.​ Advantages: 

i.​ Smaller file size 

ii.​ Faster import/export speeds 

c.​ Default output includes tie points. 
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2.​ .xml Format (Universal) 

a.​ Standard format compatible with third-party software 

b.​ BlockExchange XML Zip: Compressed version (.xml.zip) for reduced storage 

3.​ Text File (Internal/External Parameters) 

a.​ Exports camera calibration and positional data as plain text. 

Export Options: 

 

●​ For BlockExchange XML/XML Zip: 

o​ Optional: Include tie points and distortion-corrected images. 
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●​ For Tiki3D Binary Format (.at): 

o​ Optimized for Tiki3D workflows (default selection). 

 

 

Click Confirm to export. 

 

 

 

 5.3.4.7 Importing Aerotriangulation Results 

Prerequisite:​
AT results can only be imported into a blank project. Existing projects with data cannot accept AT 
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imports. 

Steps: 

1.​ Create a New AT Project: 

a.​ Start by generating a fresh project. 

2.​ Import AT Files: 

a.​ Right-click the project name → Select Import AT Files. 

 

3.​ File Selection: 

a.​ Drag and drop the AT result files (.at/.xml/.xml.zip) into the dialog box. 

b.​ To merge multiple AT tasks, add all relevant files simultaneously. The software will 
automatically combine them during import. 
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 5.3.5 Tiki3D Master Reconstruction 

 5.3.5.1 Reconstruction Parameter Settings 

Create Reconstruction Task 

After confirming the AT results, proceed with 3D reconstruction: 

1.​ Right-click the reconstruction task set → Create Reconstruction Task. (Refer to Figure 143) 

 

2.​ Enter the Reconstruction Task Name and click Next. 

Tile Coordinate System 

●​ Only available for georeferenced projects. 

●​ Defines the spatial framework for tiles (independent of the final 3D model’s CRS). (Refer to 
Figure 144) 

 
Tiki3D Master Software  89
 



 
 

 

​
Auto Waterbody Detection (beta) 

 

Model Partitioning (Tiling) 

●​ Why? Large models exceed typical PC memory limits. 

●​ Rule: Each tile’s memory usage ≤ 50% of system RAM. 

●​ Adjust Bounding Box: Drag edges in the 3D view or use constraints. (Refer to Figure 145) 
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Tiling Mode 

1.​ No Division: Single tile (not recommended for large areas). 

2.​ Planar Division: Splits along XY plane. 

3.​ Spatial Division: Divides into cubic tiles. 

4.​ Adaptive Division: Automatically balances tile size based on memory. 

Set Tile Origin 

●​ Auto-Adaptive: Centers data near the origin to avoid precision loss. 

●​ Custom: Manually set the origin (useful for model merging). 

 

Output Boundary Constraints 

Tiki3D provides multiple methods to constrain the output range of the results.   

●​ Adapt to Tie Points: During model production, all tie points are included in the production 
range (i.e., the default range).  

●​ Adapt to Cameras: Projection range of the flight's exposure point position data is used as 
the production range. 
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Boundary Constraint 

Import 

The software supports importing KML and SHP formats. For local coordinate systems, the SHP 
format is recommended. Click Import, then select the corresponding range file to import. 

Add  

Directly draw the model production range using the mouse.​
Hold ALT + Left Mouse Button to start drawing and Right Mouse Button to finish.​
Once the drawing is complete, a polygonal constraint range will be created. 

 
Tiki3D Master Software  92
 



 
 

 

​
 

Geometric Constraint 

During aerotriangulation, water surfaces, being weak-texture areas, often result in significant image loss, 
leading to holes and distortions in the model. Typically, these issues are addressed through post-modeling 
repairs. To improve this situation, water surface constraints can be added to the model. 

In introducing constraints, locate the Geometry Constraint tab. Geometric constraints support two methods for 
defining the constraint range: importing files and manual addition. Imported files support .shp and .kml 
formats. 

 

 
Tiki3D Master Software  93
 



 
 

 
 

Import 

Click Import and select the corresponding constraint range file to import. 

The software supports .shp and .kml formats. For local coordinate systems, the .shp format is required. 

Add 

If there is no predefined water surface constraint range, you can directly draw it in the 3D view. 

Hold the ALT key, use the left mouse button to start drawing, and the right mouse button to finish. 

Edit Geometric Constraints 

Right-click and select Edit Geometric Constraints to set the water surface elevation. 

Hold the ALT key and drag the Z-axis or manually input the elevation value to define the water surface 
constraint elevation. 

This process allows for precise control over water surface constraints, improving the accuracy and quality of 
the model in weak-texture areas 

 

Water Surface Constraint 

●​ Fixes water body distortions (common in weak-texture areas): 

o​ Submit reconstruction. 

o​ Import/draw water surface bounds + set elevation. 
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o​ Generate model. 

Reconstruction Output Configuration 
Select the output format and path. Individual tiles can be chosen for reconstruction, and the model coordinate 
origin can be customized. 

Output Settings (Refer to Figure 146) 

●​ Output Formats: OSGB, OBJ, DAE, 3DTiles, 3MX, LAS, Esri i3S, SuperMap S3M, FBX, Google 
Earth 3D KML, GS (3DGS-Gaussian Splatting) etc. 

o​ Note: For Fast OrthoMosaic (rapid orthophoto generation), avoid tiling. Large datasets may 
not support this output. 

●​ Output CRS: Typically matches the control point coordinate system. 

●​ Texture Quality: Ranges from 0% to 100% (original resolution) 

 

Geometry Source​
Determines the primary data used for reconstruction: 

●​ Images for Geometry: Relies solely on photos. 

●​ Hybrid (Images + Point Cloud): Balances speed and detail. 

●​ Point Cloud for Geometry: Uses LiDAR/scanned data. 
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Texture Source 

●​ Image-Based Geometry: Only imagery can be used for texturing. 

●​ Point Cloud-Based Geometry: Options include: 

o​ Fast LiDAR-Image Fusion: Lower resolution, faster processing. 

o​ Standard/Fine Fusion: Improved detail using dense point clouds. 

o​ LiDAR Only: Applies native point cloud coloring. 

Hybrid Geometry Texturing 

●​ Fusion: Combines imagery and point cloud data. 

●​ Fine/Standard Image Texturing: Uses advanced algorithms for clarity. 

Optimization Features 

●​ Dense Matching Enhancement: Repairs holes in thin structures (e.g., walls, signs). 

●​ Inter-Tile Color Harmonization: Reduces color discrepancies between tiles. 

●​ Shadow Removal: Filters out model shadows. 

●​ Texture Enhancement: Corrects artifacts like chromatic aberrations. 

Tile Selection​
Enable selective reconstruction by choosing specific tiles. 

Coordinate Origin for Published Data​
Set the model’s coordinate origin (default is recommended). For merged models, ensure consistent origins 
across all outputs. 

Task Priority 

●​ High/Medium/Low. 

Geometry Precision: 

●​ Fast: Default for quick results. 

●​ Ultra-Fine: Maximum detail (resource-intensive). 

Image Pair Selection 

●​ Standard Mode: Default pair count for general use. 

●​ Enhanced Mode: Increases pairs to improve local quality (e.g., correcting distortions in roads or 
roofs). 
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Compression  

Reduces temporary file storage by 30% (slightly increases computation time). 

Denoising 

Optimizes planar surfaces (e.g., roads, walls). 

DenseMatching Types 

1.​ Aerial Data v1.0: Legacy algorithm. 

2.​ Aerial Data v2.0 (Beta): Enhanced for buildings/roads. 

3.​ Numerical Surround v2.0 (Beta): Optimized for lattice structures (e.g., towers). 

4.​ Universal v3.0: Default hybrid mode. 

Cache & System Settings 

●​ Cache Path: Defaults to the project folder (change if disk space is limited). 

o​ Tip: Store cache files on separate drives for better performance. 

●​ Geometry/Texture Pyramids: Level 0 = highest detail. Lower levels speed up processing. 

●​ Tile Overlap: Adjust for seamless merging. Click [Finish] to start reconstruction. 
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5.3.5.2 TikiSplat (3DGS - Gaussian Splatting) 

 
Select GS (Gaussian Splatting) for Product Format 

 

 
 

Under Product Parameters, select: 
1.​ Source Data Type 
2.​ Point Cloud Density 

 
Under Additional Configuration, select: 

1.​ Spherical Harmonic Order: 1 to 3. 3 having the best resolution. 
2.​ Additional functions: 

-​ Dynamic Object Culling (Removing floating unwanted artifacts) 
-​ Export SOG LOD 
-​ Export PLY LOD 
-​ Merge Tile (Merge all tiles to produce one whole model - requires huge RAM size for 

processing hardware) 
-​ Export Orthophoto 
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‘Complete’ the Reconstruction parameter selection. The project will now be splitted up into the configured ties 
and submitted by tiles as multiple pending tasks for the engine to retrieve and begin processing. This tasks 
submission process may take up to a few minutes depending on the total number of tiles. 

 

 
 

Upon successful submission of Reconstruction Tasks, click ‘Start Engine’ to begin processing. Multiple 
Engines can be started depending on hardware specifications. 
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5.3.5.3 Tile Management 

​
 

●​ Visibility: Toggle all tiles or selected subsets in the 3D view. 

●​ Import Tile Names: Load predefined tile selections.​
​

 ​
 

Reset Options: 

●​ Full Reset: Restarts the task from scratch. 

●​ Structure/Texture Reset: Rebuilds specific components. 
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The cache for the currently selected tiles will be cleared, and the model will begin regenerating from 
scratch. 

Structure Reset Enhancement (Best for Nadir-Only Imagery)​
This option is designed for nadir-only modeling scenarios, specifically optimizing building facade 
structures to address issues such as missing, recessed, or damaged sections on building sides. 

●​ Depth Reset: Regenerates all cache files related to the tile's depth data. 

●​ Structure Reset: Retains partial cache files but regenerates both the model's geometry and textures. 

●​ Texture Reset: Only regenerates texture data while preserving the existing geometry. 

●​ Texture Enhancement: Resolves texture artifacts such as overexposed highlights ("burned" areas) 
or irregular spotting. 

Hole-Filling Method 

●​ Patch Small Holes: Fills minor internal gaps within tiles. 

●​ Patch All Holes: Completely fills all cavities in the model, particularly useful for repairing holes in 
weak-texture regions. 

Geometry Precision 

●​ Fast: Default setting, ideal for rapid modeling. 

●​ Standard: Balanced precision. 

●​ High: Increased detail, resulting in larger file sizes. 

●​ Ultra-High: Maximum precision, requiring significant memory and computation time (not 
recommended for large-scale areas). 

Forced Flattening​
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Applies artificial flattening to specific features in the model, such as water surfaces. 

Visibility Detection 

●​ Standard: Uses default texture mapping. 

●​ Enhanced: Corrects texture errors caused by occlusion by filling gaps with larger mesh patches. 

Maximum Texture Size​
Configures the dimensions of texture files. 

Sampling Interval​
Sets the sampling interval (default: 1). 

View Error Logs / Export Logs​
If reconstruction fails: 

●​ Right-click the tile → View Error Logs to quickly diagnose the issue. 

●​ If the cause remains unclear, right-click → Export Logs to save the log file for technical support. 

 

Pop-up 3D View​
Enables synchronized viewing between the 2D tile table and 3D model interface, eliminating the need to 
switch windows. 

 

 5.3.5.4 Format Conversion 

Format Conversion Tool in Tiki3D 

After model production is completed, additional output formats are often required. Tiki3D provides a format 
conversion tool to transform data formats and deliverables without reprocessing. 

How to Use 

1.​ Locate the completed reconstruction task in the project. 

2.​ Under the Reconstruction Output Set, right-click and select Convert Data Format. 
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Supported Output Formats 

Tiki3D currently supports conversion to the following formats: 

●​ OSGB, OBJ, DAE, 3DTiles, 3MX 

●​ LAS (Point cloud data in .las format; sampling interval selectable in pixels or meters)​
​

 

●​ Esri i3S, SuperMap S3M, FBX, Google Earth 3D KML 

●​ DOM/DSM (True Digital Orthophoto & Digital Surface Model)​
​
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Key Conversion Options 

●​ Fast Ortho Mosaic: Converts to .tif format (resolution depends on AT sampling rate). 

●​ DOM/DSM Generation: 

o​ Uncheck "Merge Images": Outputs tiles separately. 

o​ Check "Merge Images": Stitches into a single large image (not recommended for massive 
datasets). 

Execution & Monitoring 

●​ After submission, a new conversion task appears under the reconstruction job. 

 

●​ Launch the processing engine to begin conversion. 

●​ Track progress and output paths directly in the software interface. 
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 5.3.5.5 3D Model Result Visualization 

After the model is generated, you can review its results in the software's 3D interface. 

Navigation 

Use the mouse to navigate the 3D scene: 

●​ Left-click + drag: Adjust the viewing angle. 

●​ Mouse wheel: Zoom in/out. 

●​ Middle-click + drag: Pan the view. 

●​ Double-click: Set the focus point on a specific area. 

 

Display Options 

●​ 3D View Auto-Adaptation:​
Click this button or press the Spacebar to reset the view to the default position. 

●​ Texture Mode:​
Toggle between: 

o​ Textured View (Refer to Figure 153) 

o​ Grayscale View (Refer to Figure 154) 
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o​ Normal Map View (Refer to Figure 155) 

●​ Display Mode:​
Switch between: 

o​ Solid View (Refer to Figure 156) 

o​ Wireframe Mode (Refer to Figure 157) 

o​ Point Cloud Mode (Refer to Figure 158) 

 

Tile Selection 

●​ Single Tile: Click to select (highlighted in red). 

●​ Multi-Select: Hold Ctrl while clicking. 

●​ Box Selection: From the selection mode dropdown, choose Box Select to drag a selection area. 

 

5.3.5.6 TikiSplat - 3DGS Model Visualization 

 
 
Click ‘Open 3D Gs Model’ to view Tiki Gaussian Splatting Results 
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TikiSplat Viewer pop-up window for preview of 3DGS Model Results 

 

 
Opening Product Stored Location 

 
Scroll down to the bottom of the Properties tab, click ‘Open Product Directory’.  
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Click into ‘Data’ folder. 
 

 
 
Locate the TikiSplat 3DGS files. 
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5.4 Tiki3D Viewer Browser 
Tiki3D Viewer is a free, lightweight visualization software designed to explore and display 3D model data 
generated by Tiki3D within a unified scene. 

 

 

 5.4.1 Data Loading 

●​ Direct Folder Drag-and-Drop: 

Tiki3D Viewer automatically detects all model files within the folder. Alternatively, drag and drop an 
index file to open the model. 

●​ Supported Formats: OSGB, 3DTiles, SDB, OBJ, FBX. 

●​ Multi-Model Import:​
Simultaneously load models from multiple regions or individual tiles. 

o​ Note: For models created by other software, ensure the metadata.xml file is placed at the 
same directory level as the tile files. 

●​ Scene Merging:​
Models from the same area are automatically merged for unified viewing. 
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Post-Loading Features: 

●​ Perform measurements. 

●​ Set up navigation animations. 

●​ Save the session as a project file (File → Save) for future use. 

 

 5.4.1.1 Merging Model Files 

To merge multiple tile-based models: 

1.​ Pre-Merge Checks: 

a.​ Ensure consistent: 

i.​ Tile Coordinate System 

ii.​ Tile Origin 

iii.​ Output CRS 

iv.​ Output Origin 

b.​ Tile sizes must match or be multiples of each other. 

i.​ Purpose: Prevents naming conflicts and overlapping in merged models. 
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2.​ Merge Steps: 

a.​ Copy all tile files into a single folder. 

b.​ Drag the folder into Tiki3D Viewer to open. 

c.​ Right-click the reconstruction task → Create Index File (supports .osgb/.sdb formats). 

d.​ Open the model via the generated index file (e.g., scene.osgb). 

 

3.​ Index File Editing: 

a.​ Right-click → Edit Index File. 

b.​ Selection Tools: 

i.​ Box selection (drag between two corners). 

ii.​ Polygon selection (draw custom shapes). 

c.​ Selected tiles turn yellow; unselected tiles remain normal. 

d.​ Modify tile names as needed. 

e.​ Save changes to the index file. 
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 5.4.1.2 Merging Model Scenes 

To combine multiple 3D scenes into one project: 

1.​ Load all models into Tiki3D Viewer (no need for coordinate consistency). 

2.​ File → Save to store as a unified project file. 

 

 5.4.1.3 Index Editing 

●​ Access: Right-click the model name → Edit Index File. 

●​ Selection Methods: 

o​ Box/Polygon/Point-based tile selection. 

o​ Selected tiles highlight in yellow (both in 3D view and tile list). 

●​ Save: Export edits to a new .osgb index file. 

 5.4.2 Outputting High-Resolution Images 

Select 【Tools】→【Export High-Resolution Image】 to export a high-definition image of the current view at a 
custom resolution. 

●​ In the pop-up window, select the output path and specify the resolution (higher values produce 
sharper images). 

●​ The software generates multiple sub-images based on the resolution, which must be merged for final 
use. 

●​ The merged result is shown below. 
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 5.4.3 Measurement 

Includes: Coordinate measurement, Distance measurement, Area measurement, Volume measurement.​
Access via 【Tools】→【Measure】 or click the measurement icon. 

 

① Coordinates 

●​ Displays coordinates in the local CRS (default) or a manually selected CRS. 

●​ The measurement window shows the coordinates of the clicked position. 
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② Distance, Area, Volume 

●​ Distance: 

o​ Left-click to start, right-click to end. 

o​ Measures multi-segment lengths and total distance. 

 

●​ Area: 
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o​ Left-click to draw a polygon, right-click to close. 

o​ Calculates surface area and perimeter based on the 3D contour’s average plane projection. 

 

●​ Volume: 

o​ Measures the volume between a reference plane and the 3D model. 

o​ Left-click to define the contour, right-click to finish. Press Spacebar to undo the last point. 

o​ Cut Volume: Volume above the reference plane. 

o​ Fill Volume: Volume below the reference plane. 
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 5.4.4 Browsing Modes 

●​ Wireframe Mode: Press W. 

●​ Texture Mode: Press T. 

●​ Fullscreen Mode: Press F11. 
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Tile Name Inspection 

●​ Tile Marking Tool: 

o​ Select tiles by name and export the list to a TXT file. 

o​ Access via 【Tools】→【Tile Marking Tool】. 

o​ Right-click tiles to mark them; add notes in the table’s second column. 

o​ Save the marked tiles after completion. 
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 5.4.5 Model Animation 

1.​ Right-click the Navigation Animation Bar → New Path (or load a CC animation path). 

2.​ Adjust viewpoints and set transition times for speed control. 

3.​ Right-click the path → Play to start the fly-through. 
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 5.4.6 Deformation Detection 

1.​ Click the Generate DEM icon. 
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2.​ Set sampling interval and elevation tolerance. 

3.​ The software automatically compares data and calculates volumetric differences between terrains. 

4.​ Switch to White Model Mode for clearer visualization. 

 5.4.7 Split-Screen Mode 

Compare terrain changes between two time periods. 

1.​ Load both models into Tiki3D Viewer (ensure alignment). 

2.​ Right-click Model A → Set as Left Swipe Layer. 

3.​ Right-click Model B → Set as Right Swipe Layer. 

4.​ Click the Swipe Tool icon. 

5.​ Hold Ctrl + Drag to adjust the swipe position. 

 

 5.4.8 Accuracy Verification  

1.​ Click Accuracy Check, then select the checkpoint file’s CRS. 

2.​ File format: Point Name, X, Y, Z. 

3.​ Double-click a checkpoint, then click its location in the model to display the error. 

4.​ Export a full accuracy report after verification. 
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